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Formerly titled
Microsoft Visual C++ Owner’s Manual

Introduction

This book is about Microsoft Visual G++. Not the G+ language, not the
MFC library, just Visual C++ itself.

True, Visual C++ already comes with a sort of programmer’s guide—it’s
called online help. The vastness of the help system will probably inspire
in you the confident belief that what you want to know is in there some-
where. But that’s the problem with online help: it works best when you
know what you’re looking for. This book complements online help, but
does not replace it. Purposes and styles of the help system and the written
word are inherently too different for one to supplant the other. Where
one dispenses information, the other teaches, if you see what I mean.
Where one has breadth the other has depth. In presenting the cold facts
as tersely as possible, online help can’t afford to elaborate, giving you
instead a list of steps to follow to accomplish some task but rarely taking
the time to paint a larger view. You get the how that informs but not the
why that teaches.

This book intends to make you a proficient user of Visual C++. It unfolds
in a logical progression of material, demonstrates how parts of the whole
interact, clarifies with sample code, and generally acts as a tutor. More-
over, you can curl up with it in your favorite chair. These are exactly

the advantages that online help lacks. Help, on the other hand, offers
immediacy and breadth. The many megabytes of help text can touch every

Xiii
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obscure corner of Visual C++, while this book covers only the essentials.
Start with this book to acquire a solid grounding in the art of Visual C++,
then turn to online help as you become more experienced and your ques-
tions more arcane. Paradoxically, the more adept you are with the product‘
the more online help will be of service to you.

The book is older than its title. The first edition appeared as Microsoft
Visual C++ Owner’s Manual, becoming Microsoft’s official guide for
Visual C++ version 5. But Microsoft has retitled this second edition to
position it as part of a five-volume set of Programmer’s Guides document-
ing the development tools of Visual Studio 98, including Visual Basic,
Visual J++, Visual FoxPro, and Visual InterDev. The Guides function
independently, however, so if your interest is confined to Visual C++,
you’ve come to the right place. Any similarities between this Guide and
the others stops at the cover, since the other books are printed copies of
online help, exact reproductions of the online documentation that comes
with each product. You will find this book very different from the other
Guides in the set.

Microsoft has good reasons for renaming the book, but I regret losing the
original title. I chose Owner’s Manual to convey as clearly as possible the
focus of the book to make sure that you, the reader, have an idea of what’s
covered and what isn’t. A hundred years ago in an age more tolerant of
lengthy titles I could have tacked on something like, Being a Tutorial,
Companion, and Reference Intending to Further Knowledge of and Famil-
iarity with the Microsoft Visual C++ Compiler, Without Digressing into the
Interesting Though Ancillary Subjects of the C++ Programming Language
and the Microsoft Foundation Class Library. Admittedly, that scholarly
title wouldn’t be entirely accurate. Visual C++ is so integrally tied to the
C++ language and the MFC library that it’s impossible to talk intelligently
about Visual C++ while remaining mute on the other two subjects. The
chapters that follow present many example fragments and programs, the
purpose of which is to illustrate some aspect of Visual C++. Code must
have commentary—it’s useless otherwise—and descriptions of the exam-
ple programs necessarily spill over into the topics of technique and MFC.
But these occurrences are isolated and do not distract from the main focus
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of how to use the compiler. Other excellent books are available that
explain C++ programming and the MFC library.

This book describes version 6 of Visual C++, but owners of earlier ver-
sions can also benefit from a reading. Some aspects of Visual C++ have
changed considerably since previous versions, but many other areas have
changed little or not at all. These days Visual C++ comes in a deceptively
slim package containing a few flyers, some printed material, and a CD-
ROM or two. But since you’ve read this far you probably realize an
immense amount of material exists in Visual C++. I call it a “compiler”
only for lack of a better name. Besides the compiler itself, Visual C++ pro-
vides a linker, a make utility, a debugger, a text editor, resource editors, a
development environment, the Microsoft Foundation Class library (MFC),
run-time libraries, many thousands of lines of source code, and a lot more.
To repeat: this book does not examine everything. My aim is to help you
master Visual C++, not bury you in minutiae.

What You Should Already Know

A book of this type has to begin on the learning curve somewhere above
point zero. Start too low and discussions become hopelessly muddled
with preliminary explanations. Start too high and the author loses much
of his audience (besides coming across as a pinhead). The trick is to speak
in one voice to a readership made up of widely varied skills and interests,
yet lose no one when speaking of esoterica and insult no one when pre-
senting the fundamentals. The book makes no great demands. I assume
you are already familiar with the C and C++ programming languages, have
programmed before for Windows, and have at least a nodding acquain-
tance with MFC. You don’t have to be an expert by any means, but you’ll
find the text and sample code easier to follow if you understand basic
ideas such as pointers, classes, and messages. Fortunately, there’s nothing
abstract about a compiler. It’s just software.

A Brief History of Visual C++

One can make a case that the roots of Visual C++ began not with Microsoft
but with Borland. Some readers may remember Turbo Pascal, which

XV
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Xvi

brought to DOS the idea of the integrated development environment or
IDE. IDE is yet another abbreviation in a field already top-heavy with
them. It just means the editor and the compiler work together, both acces-
sible from the same place. You write your source code in the editor, hit
the Compile button to launch the compiler, and when it finds an error the
compiler sets the editor’s cursor on the offending statement, ready for you
to correct the problem. The idea is to provide an environment for program
development that the programmer never has to leave. '

The C language was catching on at this time (c. 1987), and Turbo Pascal
led to Turbo C. Microsoft countered with a similar product named
QuickC. I was contracted to do some programming work associated with
QuickC and ended up writing a few chapters of a how-to book included in
the package, titled C for Yourself. (The title wasn’t my idea.) QuickC sold
as a stand-alone product but was also included as part of Microsoft’s C
compiler, which we called Big C. At the time, Big C stood at version 5.

Its competition included names from what now seems a misty past: Com-
puter Innovations, Datalight, Lattice, Manx. Others of that era have sur-
vived, notably Borland and Watcom (now PowerSoft). Their fine products
continue to provide healthy competition for Microsoft.

The purpose of pairing QuickC with Big C was so programmers could
write code in QuickC’s convenient IDE. QuickC offered fast compile times,
mostly because it made only the faintest attempts at code optimization. -
(We’ll talk about optimization later in this book and see how it can affect
build times.) When it came to optimizing, QuickC was happy to enregister
some variables, insert a few LEAVE instructions, and call it a day. The
result was quick compiler turnaround. After a program was debugged and
running in QuickC, the programmer could then create a release version
with Big C, which was far more serious about code optimization. It wasn’t
unusual to shave 15 percent or more off the size of a program when com-
piled with Big C.

QuickC and Turbo C introduced many to C programming, but never
earned the permanent affection of developers. For one thing, the editors
of both products were not very good. (The QuickC editor was later incor-
porated into Microsoft QuickBasic and still exists today in Microsoft
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Windows 95 as the DOS editor Edit.com.) Another problem with IDEs
under DOS was that they took up a lot of memory, leaving little for execut-
ing the program under development. You often had to exit the IDE to run
and debug your program. Many programmers who used QuickC in devel-
opment work (myself included) relied only on its command line version.

But then Windows 3.0 came along.

Windows 3.0 and especially 3.1 ushered in the era of the serious IDE for .
the personal computer. The constraints of memory disappeared. And if you -
were going to program for Windows, a Windows environment seemed a
natural place to be. It was clear that programming for Windows in Windows
produces better products. Windows is a mindset, and working in it all day |
gives one better instincts about what a program should or should not do.

To the surprise of many, Microsoft concentrated its efforts in shoring up
the internals of its C compiler rather than in upgrading its interface for the
new age. When version 7 came out it was still a DOS-based product that
ran either in a DOS box in Windows or with an extended memory man-
ager (it came with Qualitas’s 386Max right in the box). As a concession,
version 7 offered a character-mode IDE named Programmer’s Workbench
that was cumbersome by today’s standards. Nevertheless, the Workbench
demonstrated a natural evolution from the days of QuickC. Many com-
mands from its menus still seem modern, such as New, Open, Savye As,
Build, and Open Project.

The important contribution that version 7 made to the programming world
was not its IDE but its support for C++. For the first time, Microsoft desig-
nated its compiler “C/C++” to emphasize its new dual nature. It was like
watching a cell undergo mitosis. The support involved more than simply
expanding the compiler to recognize new commands of the C++ superset.
C/C++ version 7 also introduced version 1 of the Microsoft Foundation
Class library, complete with source code. C++ would not be so popular a
vehicle for Windows programming today without this competent set of
prewritten classes, which Microsoft wisely gave away to developers.

With the next major release, Microsoft abandoned most of its product’s
ties to DOS. Microsoft C/C++ version 8, which sported a real Windows
IDE, became known as Visual C++ version 1. The name capitalized on the

Xvii
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success of the earlier Visual Basic but the two products never compared
very well. Where Visual Basic allows the developer to build a working
Windows program with lots of clicking and little coding, Visual C++ cre-
ates only starter source files through special dynamic link libraries called
wizards. As we’ll see in Chapter 2, wizards save much of the repetitive
front-end work of development, the kind of work common to many Win-
dows programs written with MFC. ’

After Visual C++ 1.5, Microsoft decided not to invest any more effort in
supporting 16-bit programming. Visual C++ 2 still offered 16-bit support,
but since then Visual C++ creates only 32-bit applications. There never
was a Visual C++ 3. The release number skipped from 2 to 4 to synchro-
nize Visual C++ and MFC, thus ending a small source of confusion. The
consolidation was short-lived, however, since Visual C++ and MFC again
use different version numbers.

The popularity of the Internet has clearly influenced the product’s design,
and in its fourth release Visual C++ introduced new library classes
designed for Internet programming. Version 5 also added some new
classes, but concentrated more on improving the product’s interface to
provide a better online help system, much superior macro capabilities,
and support for sharing classes and other code within a team of develop-
ers. Version 5 also integrated the Active Template Library and signifi-
cantly improved the compiler’s ability to optimize code. As we will see in
later chapters, version 6 extends these improvements even further.

What's in this Book

xviii

The book is divided into six main sections, each covering a general subject
about Visual C++ and its development environment. Discussions are

intentionally kept basic up through Chapter 3, which covers the text edi-

tor. This helps ensure that every reader, whether novice or expert, is able
to successfully navigate the Visual C++ development environment and
write source code in the text editor. Beginning with Chapter 4, discussions
gradually become more technical.
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Part 1—Basics

Much of what we call Visual C++ is actually its development environ-
ment, named Microsoft Developer Studio. Distinguishing between the two
isn’t important, and usually the terms are interchangeable. But you can’t
use Visual C++ effectively until you learn your way around Developer
Studio. (Developer Studio sounds a lot like Visual Studio, but they have no
relationship, so you can forget about Visual Studio throughout this book.)

Chapter 1 is an orientation session, introducing Developer Studio and
describing the main windows you will encounter when working in the
environment. The chapter also explains how to use Microsoft Developer
Network (MSDN), which serves as the online help system for all Microsoft
programming products, including Visual C++.

Chapter 2 introduces AppWizard, the Visual C++ wizard program that cre-
ates starter files for a typical Windows application using MFC. We’ll use
AppWizard throughout the book to create some of the example programs.

Part 2—Editors

Visual C++ provides three different editors—one for creating text source
code, another for menus and graphics files, and the third for dialog boxes.
Each editor gets its own chapter, starting with the text editor in Chapter 3.
This chapter examines important menu commands, shows shortcuts for
opening text documents, and introduces macros.

Chapter 4 describes Visual C++’s multitalented graphics editor, used to
create resource data including menus, bitmaps, icons, and toolbars. This
chapter is lengthy, as befits the amount of material it needs to cover. An
example program named DiskPie1 takes shape as the chapter progresses.

-Each main section first describes how to use the graphics editor to create a
particular interface element such as a menu or toolbar, and then demon-
strates by adding the element to the DiskPie1 program. By the end of the
chapter, the program is a useful utility that dlsplays disk and memory
usage in the form of a pie chart.

Chapter 5 covers the dialog editor, showing how to use Visual C++ to
design dialog boxes and create dialog-based applications like the Win-
dows Character Map and Phone Dialer utilitiés. The chapter demonstrates

Xix
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with several examples, including one that creates a property sheet, also
known as a tabbed dialog.

Part 3—Programming Assistance

The chapters in Part 3 show how to use two essential tools in Visual C++
to speed program development. Chapter 6 introduces ClassWizard, which
is hard to describe but easy to love. When developing MFC applications,
you will find ClassWizard invaluable for creating and maintaining classes.

The Gallery, described in Chapter 7, offers a collection of add-in compo-

nents that you can incorporate into your projects with just a few clicks of
the mouse. Visual C++ comes with a number of ready-made components

consisting of both class source code and ActiveX controls. Chapter 7 also
demonstrates how to create your own components for the Gallery.

Part 4—ActiveX Controls

Chapter 8 introduces ActiveX controls and shows how to use them in your
applications. Chapters 9 and 10 take the opposite tack and explain how to
write an ActiveX control using either MFC or the Active Template Library
(ATL). Chapter 9 presents a well-documented example named Tower that
takes you step by step through the creation and coding of an ActiveX con-
trol that relies on MFC. Chapter 10 then creates the same control using the
Active Template Library, providing a clear illustration of the differences
between the two approaches. The results can be embedded in any applica-
tion that supports ActiveX controls.

Part 5—Advanced Topics

Chapter 11 covers the essential subject of the debugger, one of Visual C++’s
most perfect elements. The chapter examines the internals of debugging,
describes the debugger windows and toolbars, then puts the debugger
through its paces by fixing the hidden flaws of an example program.

After an application is debugged, you will want to turn on compiler
optimizations to create a release version. Chapter 12 covers the often
poorly understood subject of compiler optimization, showing you exactly
what each of the many Visual C++ optimization switches do—and why.
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By the time you get to Chapter 13 you will have spent a lot of time in the
Developer Studio environment, enough to know what you like and what
you would prefer to change. This chapter shows how to customize

Visual C++ to suit your tastes. It also demonstrates through examples how
to program macros and add-in utilities that integrate seamlessly into
Developer Studio.

Part 6—Appendixes

Appendix A presents standard tables that list ASCII and ANSI characters.
You may find the ANSI table in Appendix A more useful than similar
information in online help because the table shows octal numbers for the
characters. There’s a good reason for this. As we’ll see in Chapter 5,
including upper ANSI characters in dialog text requires the character’s
number in octal form. Armed with this information, you can add useful
symbols such as © and % to text strings displayed in a dialog.

Appendix B briefly describes the MFC classes that ClassWizard supports,
serving as a quick reference designed to help you select the most appropri-
ate base for your new class.

Appendix C provides an introduction to Microsoft Visual Basic Scripting
Edition, better known as VBScript. Visual C++ incorporates VBScript as
its macro language, so a primer is helpful if you have never before used
VBScript or a similar Visual Basic dialect. Although recording macros in
Visual C++ requires no knowledge of VBScript, you can create a general-
purpose macro only by using VBScript programming.

Example Code

Nearly every example program in this book is written in C++ and uses
MFC. (The two exceptions are a cursor demonstration program in Chapter
4 and a small console-based utility presented in Chapter 13.) But I rely on
C for some of the code fragments within the text. I find C++ isn’t as good a
medium as C for succinctly illustrating a programming idea, and besides
the advantages of clarity and brevity, C serves as a sort of lingua franca
among today’s programmers. In theory, C++ programmers understand
straight C but the reverse is not necessarily true. On the other hand, C has
no place in demonstrating MFC applications. I occasionally present

XXi
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equivalent C and C++ code when I think the idea is important enough and
the differences significant enough to warrant translations.

Many of the chapters in the book cover topics that are best demonstrated
by example, and I've tried to include sample programs that are at once
interesting, useful, and illustrative. Some of the programs are created with
AppWizard and others are not, thus simulating as wide a range of pro-
gramming practices as possible. Nearly every program is supplemented
with a thorough discussion in the book text. The text also includes source
code listings, so you needn’t open a source file in the editor to follow a
discussion. Program code strives for clarity over elegance, so you will no
doubt see sections of code that you would handle differently in your own
development work. For example, I've included very little error checking
in the programs. The programs were created in Windows 95, but most
have been tested under Microsoft Windows NT.

The Companion CD

XXii

The project files for all sample programs are on the companion CD
attached to the back cover of the book. To copy all the projects to your
hard disk, run the Setup program by following these steps:

1. Click the Start button on the Windows taskbar and choose the Run
command.

2. Type “d:\setup” in the Run dialog, where d represents the drive let-
ter of your CD-ROM drive.

The Setup program copies more than 3 MB of files from the CD to your
hard disk, placing them in a subfolder named Visual C++ Programmer’s
Guide (or whatever name you specify). Running Setup is entirely optional,
and you can retrieve files manually from the CD if you prefer. You will
find all files located in the Code subfolder.

Nested subfolders refer to the chapter number where the program is
described and to the project name. The subfolder Chapter.05\MfcTree,
for example, holds all the files required to build the MfcTree program
presented in Chapter 5. Each project folder has a subfolder named Release
that contains the program executable file, so you can try out a sample
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program without having to build it. If you want to follow a discussion in
the text by building the sample program, start Visual C++ and choose the
Open Workspace command from the File menu. Browse for the project
folder on your hard disk and double-click the project’s DSW file.

Project names for the example programs are kept to eight characters or
less. This convention accommodates those readers who prefer to use an
older text editor that may not recognize long filenames. Some older CD
drives also have problems with long filenames.

The companion CD includes a program I wrote named Index. Index is not
a sample program, so you won't find it described anywhere in the book
chapters. Index supplements the book index, performing a full-text search
through all the chapters and the appendixes. It ensures that if a subject is
mentioned anywhere in this book, you can find it. The program is actually
an electronic form of what bibliographers call a concordance—given one
or more words, it tells you on what pages and in what paragraphs the
words occur. To use the program, copy the files Index.exe, Index.hlp, and

Index.key from the CD to your hard disk, making sure you place the three
files in the same folder. Or you can run Index straight from the CD if you
prefer. Here’s what the program looks like:

The four combo boxes in the Index dialog window each accept a single
word. The words can form a phrase such as “Active Template Library” or

Xxiii
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simply specify unconnected words that occur together in the same para-
graph or on the same page. The program also searches for plurals and
word variations formed by -ed and -ing, and is intelligent enough to
account for slight changes in spelling. Searching for the words edit, han-
dle, and debug, for example, also locates occurrences of the words edits,
handling, and debugged. Letter case of the search words does not matter, a
simplification that on rare occasions may lead to an unexpected match, as
when Index locates the word guiding when searching for the acronym
GUID. To run a search, click either the Search button or the book icon.

The four combo boxes remember previous search words, so you do not
have to retype an entry. To recall a word you entered previously, expose
the box’s list and select the word. Pop-up help messages explain other fea-
tures of the program. Just click the small question mark button at the
upper-right corner of the dialog and then click a control window or group
box area. Users of Windows NT 3.51 must press the F1 key for help.

Index identifies each paragraph on a page by a number such as 2 or 7. As
you scan a page to find a particular paragraph indicated by the program,
keep in mind these rules that determine what the program considers a
paragraph to be:

B The caption of a figure constitutes a separate paragraph, as does
each row of a table.

B Each line of source code (except blank lines) represents a paragraph.

W A partial paragraph at the top of a page does not count as a separate
paragraph because Index assumes the text belongs to the paragraph
at the bottom of the preceding page.

The Index program recognizes the Boolean operators AND, OR, and NOT.
If you are a little rusty on Boolean logic in full-text searches, Chapter 1
describes how to use the same operators when searching the MSDN online
help system. See Table 1-1 on page 26 for examples.
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A Few Definitions

Before getting further into the book, a few terms should be defined, such
as build, project, target, configuration, and application framework. Since
I'll use these words in the chapters that follow, it’s best to define them now.

Build means to compile and link, transforming a collection of source files
into an executable application. You compile a source file; you link object
files; you build a project. Project has two related meanings. It can mean
the end-product—that is, the application you build—but the term more
correctly refers to the collection of files that create the application, includ-
ing source files, precompiled headers, resource scripts, graphics files, and
whatever else is required to build the program. Visual C++ lets you open
only one project at a time, which means you have ready access to all the
project files and can edit, build, or debug. Each project can hold any num-
ber of nested subprojects, an arrangement that makes sense when you are
developing a program consisting of more than one executable element. For
example, you might develop an application as a main project while main-
taining an auxiliary dynamic link library as a separate subproject.

When you build a project, the application you create is one of two types,
either release or debug. Visual C++ sometimes uses the term target to refer
to the build type. The project’s release target is the executable program
you give to your end-users. The debug target is the executable you work
on during program development. The project settings, known as the con-
figuration, determine the type of executable—release or debug—that
Visual C++ creates when building the project.

The MFC library of general classes is designed to make Windows program-
ming easier by representing the Win32 API as a set of class objects. A
program using MFC takes advantage of tested code that serves as an appli-
cation framework, handling many tasks the application would otherwise
have to take care of itself. The only costs of these hidden services are a
potentially larger executable size and a certain built-in rigidity common

to most MFC programs. Through its classes, the framework dictates the
structure of the application but not the details. However, MFC does not
seriously constrain the programmer’s creativity, as evidenced by the many
diverse Windows applications written with MFC.

XXV
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Further Reading

XXVi

Recommending books is an uncomfortable responsibility and I don’t take
it on lightly. Books are expensive, not just in terms of money but espe-
cially in terms of time. That said, here are a few works that I believe repre-
sent worthwhile investments for programmers using Visual C++. They all
happen to be published by Microsoft Press, but that’s only because I don’t
get out much.

m To begin learning about MFC, I believe you can’t do better than Jeff
Prosise’s Programming Windows 95 with MFC. I like this book. It’s
well written, clear, and stays consistently with its subject without
wandering off somewhere else.

B Another good work on MFC is David Kruglinski’s Inside Visual C++.
Don'’t let the title fool you—this book concentrates on MFC, cover-
ing topics that the Prosise book does not such as database manage-
ment and OLE. The discussions and all the example programs
assume the reader is using Visual C++.

m If you are new to Windows programming, want grounding in the
basics, and prefer to program in the C language rather than C++,
consider Programming Windows 95 by Charles Petzold and Paul
Yao. The latest of a series of editions that first appeared almost a
decade ago, this book is justly famous for the clarity it brings to the
subject of Windows programming. Note the caveats, though—except
for the last chapter, the book makes no mention of C++ or MFC.

W For a good introduction to ActiveX, try David Chappell’s Under-
standing ActiveX and OLE. Though it has nothing to say about
Visual C++ and very little about programming, this readable book
offers a good overview of a complex subject.

Feedback

If you have any suggestions for future editions of this book, drop me a
line. I will try to read every piece of e-mail I receive (I'm pretty diligent
about these things), though I can’t promise an answer. You can reach me
via the Internet at beckz@witzendsoft.com.
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Chapter

The Environment

The Visual C++ package comprises many separate pieces such as editors,
compiler, linker, make utility, a debugger, and various other tools
designed for the task of developing C/C++ programs for Microsoft Win-
dows. Fortunately, the package also includes a development environment
named Developer Studio. Developer Studio ties all the other Visual C++
tools together into an integrated whole, letting you view and control the
entire development process through a consistent system of windows,
dialogs, menus, toolbars, shortcut keys, and macros. To use an analogy,
the environment is like a control room with monitors, dials, and levers
from which a single person can operate the machines of a sprawling fac-
tory. The environment is roughly everything you see in Visual C++. Every-
thing else runs behind the scenes under its management. '

Distinguishing between the product Visual C++ and its environment
Developer Studio serves little purpose because the latter so completely
represents the former. Rather than deal with yet another name, this book
applies the term Visual C++ in a general sense that refers interchangeably
to both the entire product and its development environment. Microsoft
itself has adopted this course, and users of previous versions will notice
that windows once labeled Developer Studio have been retitled Vis-

ual C++. We will resurrect the old name in the final chapter, however,
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when discussing how utility programs can integrate with the Developer
Studio program to become part of the environment.

Let’s begin this chapter with a summary of some of the many services pro-
vided by the Visual C++ environment that are designed to assist program
development. Chapter numbers in parentheses indicate where in the book
we will examine these services in detail:

B Windows that provide views of different aspects of the development
process, from lists of classes and source files to compiler messages
(this chapter).

W Menu access to an extensive system of online help (this chapter).

W A text editor for creating and maintaining source files (Chapter 3),
an intelligent dialog editor for designing dialog boxes (Chapter 5),
and a graphics editor for creating other interface elements such as
bitmaps, icons, mouse cursors, and toolbars (Chapter 4).

M Wizards that create starter files for a program, giving you a head -
start on the mundane task of setting up a new project. Visual C++
provides wizards for various types of Windows programs, including
standard applications with optional database and Automation sup-
port (Chapter 2), dynamic link libraries, dialog-based applications
(Chapter 5), extensions for a Web server using the Internet Server
API (ISAPI), and ActiveX controls (Chapters 9 and 10).

B ClassWizard, an assistant that helps create and maintain classes for
MFC applications (Chapter 6).

B Drop-in executable components maintained by the Gallery (Chap-
ter 7) that add instant features to your programs.

B An excellent debugger (Chapter 11).

B Logical and convenient access to commands through menus and
toolbars. You can customize existing menus and toolbars in Vis-
ual C++ or create new ones (Chapter 13).

B The ability to add your own environment tools through macros and
add-in dynamic link libraries (Chapter 13). You can develop these
additions yourself or purchase them from various vendors.
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Figure 1-1.

Figure 1-1 shows a typical view of the Visual C++ main window. The
environment’s appearance has changed only slightly since the previous
version, and its style and many of its commands remain unaltered. If you
are familiar with the Developer Studio environment from previous ver-
sions of Visual C++ or other Microsoft products, you may want only to
skim this chapter to touch on the new features, especially the revised
online help system. If you have never used Visual C++ before, you will
find that like any large Windows program it may take some getting used
to. Don’t underestimate its depth—just when you think you’ve discovered
everything about Visual C++, another corridor opens up. But the interface
is intelligent and so forgiving that it encourages experimentation, always
the best teacher.

22 The one and only CCubedpp object
1 llccubeapp theApp:

‘ ///////////////////////////////////////////
1; </ CCubedpp initialization

Cubedoc.cpp
Cubeview.cpp
Mainfrm.cpp
Stdafx.cpp
Header Files
Resource Files }public:
_CCubelpp()

{{Compiling resources. ..
4Compiling. ..
qs

A typical view of Visual C++’s main window.

This chapter is a start, introducing you to the Visual C++ environment

shell and describing the interface and windows you will encounter when

working on a development project. We won’t worry about individual tools
and menu commands at this stage, since every chapter that follows
describes at least one menu and toolbar and the various commands they
contain. At one time Developer Studio also served as host environment for
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Visual J++ and Visual InterDev, but here we concentrate only on how the
environment applies to Visual C++ and C/C++ projects.

" Toolbars and Menus

Visual C++ comes with an arsenal of predefined toolbars that provide one-
click access to the most frequently used commands. And if you don’t see
what you need, you can augment the environment’s collection of toolbars
with custom toolbars of your own design. Each toolbar is identified by a-
name that appears in the bar’s title strip:

As described in the next section, toolbars are often “docked” into position,
in which case the title strip disappears. For example, Figure 1-1 shows
what the Standard, Build, and Edit toolbars look like in their docked loca-
tions at the top of the Visual C++ main window. Toolbar arrangement is
up to you. You can move toolbars around on the screen, adjust their rect-
angular shapes by dragging an edge, and make any set of toolbars visible
or invisible. While you may prefer to have some toolbars such as Standard
and Build visible at all times, other toolbars normally become visible only
when you work in a window that requires them. The Debug toolbar, for
instance, is visible by default only during a debugging session. The Colors
and Graphics toolbars (described in Chapter 4, Resources) are visible only
in the graphics editor, because that’s the only place you need them. Figure
1-2 shows a list of toolbar names contained in the Customize dialog, in
which you can toggle a toolbar’s visibility on and off by clicking a check
box. To open the dialog, click the Customize command on the Tools
menu. (Chapter 13, Customizing Visual C++, has much more to say about
the Customize dialog). '

As the mouse cursor passes over a toolbar button, the button takes on a
distinctive raised appearance. The status bar at the bottom of the main
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Figure 1-2. Turning toolbars on and off in the Customize dialog.

window displays a brief description of the button and, if the cursor rests
momentarily on the button, a small pop-up “tooltip” window appears con-
taining the button name. On request, Visual C++ can even display
enlarged versions of its toolbars:

Normal size Large size

Both the tooltips and enlargement options are controlled in the Customize
dialog box shown in Figure 1-2.

The Visual C++ menu bar is a special form of toolbar. Although you can
hide the menu bar only in full-screen mode, it otherwise behaves much
like a normal toolbar. Menu names on the Visual C++ menu bar take on
the same raised appearance as toolbar buttons when the mouse cursor
passes over them. When you click a menu name to pull down a menu, the
name seems to recess into the screen. With a menu open, glide the cursor
from one menu name to another to pull down other menus.
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‘Context Menus

The Visual C++ environment almost always responds to clicks of the
right mouse button, usually displaying a pop-up context menu with
commands appropriate to the situation. Even when no windows are

~ open in Visual C++, right-clicking the empty client area produces a
menu with commands that make windows visible and toggle toolbars
‘on and off. To expose the same menu, right-click anywhere ona
toolbar except its title strip. Experiment with the right button as you
work, and you will uncover a wealth of other convenient shortcuts.

You can drag toolbars and the menu bar into new positions on the screen
by clicking and holding any area of the bar that is not a button or menu
name. If the toolbar’s title strip is not visible, the vertical separator bars
that appear in many of the toolbars are a good place to “grab” a bar for
dragging. Because of the docking feature, moving toolbars in Visual C++
is sometimes not as straightforward as you might expect. The next sec-
tion delves into the secrets of repositioning windows and toolbars on

the screen.

Environment Windows

Besides its many dialog boxes, Visual C++ displays two types of windows,
called document windows and dockable windows. Document windows
are normal framed child windows that contain source code text and
graphics documents. The Window menu lists commands that display doc-
ument windows on the screen in a cascade or tiled arrangement. All other
Visual C++ windows, including toolbars and even the menu bar, are
dockable. The environment has two main dockable windows, called
Workspace and Output, that are made visible through commands on the
View menu. Other dockable windows, described in Chapter 11, The
Debugger, appear during a debugging session. This section first looks at
some of the characteristics common to all dockable windows, and then
examines the Workspace and Output windows individually.
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A dockable window can be attached to the top, bottom, or side edges of
the Visual C++ client area, or disconnected to float free anywhere on the
screen. Dockable windows, whether floating or docked, always appear on
top of document windows. This ensures that floating toolbars remain visi-
ble as focus shifts from one window to another, but it also means that
document windows can occasionally seem to get lost. This can be discon-
certing the first few times it happens, but have faith that the document
window is still there. If you are working on source code in the text editor,
for instance, and then turn on a dockable window that occupies the entire
Visual C++ client area, the source code document disappears, buried
beneath the new window. If the overlaying window is docked into posi-
tion, you cannot bring the source document window back to the top. The
only solution is to either turn off the overlaying window or drag it out of
the way. We’ll see how to turn dockable windows on and off in a moment.

As you drag a dockable window, a moving outline appears that shows
what the window’s new location will be when you release the left mouse
button. The outline is a fuzzy gray line until it comes in contact with an
edge of the environment’s client area or the edge of another docked win-
dow, at which point the outline changes to a thin black line. The change is
a visual cue to notify you that dropping the window will cause it to dock
into place against the nearest edge. A toolbar docks into a horizontal posi-
tion against the top or bottom edge of the client area and into a vertical
position when placed against the left or right side. You can reorient the
toolbar’s placement by pressing the Shift key while dragging the toolbar.

Getting a window to dock in the desired size and position sometimes
takes several attempts. To dock a window so that it occupies the entire cli-
ent area, drag it upward until the mouse cursor comes in contact with the
top edge of the client area, and then release the mouse button. To coax the
docked window back to a smaller size, drag the window until the cursor
touches the left edge of the client area. This forces the window to undock,
allowing you to drag the window by its title bar to a different location.

When you move a dockable window around on the screen, the window
may seem to have a mind of its own, clinging tenaciously to an edge of the
Visual C++ main window or to any other docked window it comes in
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Figure 1-3.

contact with. You can prevent this in two ways. The first method is to
press the Ctrl key while moving the window to temporarily suppress its
docking feature. The second method works only for windows, not
toolbars, disabling the window’s docking ability until you enable it again.
Right-click inside the window and choose the Docking View command
from the window’s context menu to turn off the command’s check box

icon. The Window menu also provides access to the Docking View com-
mand, as shown in Figure 1-3.

Workspace ‘Cube”: 1 project(s)
& Cube files
£3-(2) Source Files

Toggling a window’s docking mode with the Docking View command.

Disabling a window’s docking feature affects the window’s behavior in
several ways:

®m The window appears as a normal document window, with buttons
in the title bar that minimize, maximize, and close the window.

B The window’s position is arranged along with any open document
windows when you choose the Cascade or Tile command from the
Window menu.

B The window cannot be moved above the client area of the
Visual C++ main window as it can when in docking mode.

B Given input focus, the window can be closed with the Close com-
mand on the Window menu. The Close command otherwise does
not affect a window in docking mode, even if it has focus.

When a window or toolbar is docked, distinctive raised knurls, sometimes
called gripper bars, appear at the window’s top or left edge, as shown in
Figure 1-4. Double-clicking the gripper bars makes a window or toolbar
float free; double-clicking the title bar of the floating window or toolbar
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Figure 1-4.
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When docked, windows, toolbars, and the menu bar have raised gripper bars.

returns it to its previous docked position. You can also drag a window by
its gripper bars into another docked or free-floating location.

The window arrangement you create in Visual C++ lasts for the duration
of the project or until you change it. The next time you open the project,
windows appear as you left them. Windows belonging to utility programs
executed within the environment are not subject to the environment’s
rules, however. Such windows are neither document nor docking win-
dows, and their characteristics are determined by the utility program, not
Visual C++.

The Workspace and Output Windows

Visual C++ displays information about a project in the Workspace and
Output dockable windows, shown in Figures 1-1 (page 5), 1-6 (page 13),
and 1-7 (page 14). We’ll encounter these important windows throughout
the book, especially the Workspace window, so it’s worthwhile spending
some time examining how they work.

To make the Workspace or Qutput window visible, click its name on the
View menu, as shown in Figure 1-5, on the next page. (The command is
not a toggle, so clicking it again does not make the window invisible.) The
windows are also activated by their own buttons on the Standard toolbar,
which when clicked make the windows visible or invisible.

11
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Figure 1-5.
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Displaying the Workspace and Output windows. The tool buttons
are on the Standard toolbar.

In addition to using the toolbar buttons, you can hide the Workspace and
Output windows in several other ways:

m If the window is floating, click the Close button on the window’s
title bar.

B If the window is docked, click the small X button located above or
to the right of the window’s gripper bars (see Figure 1-4).

B Right-click anywhere in the window to display a context menu and
choose the menu’s Hide or Close command. Which command
appears on the menu depends on whether the window’s docking
mode is on or off, but both commands have the same effect.

m If the window’s docking feature is disabled, click the window to
give it focus and choose the Close command from the Window menu.

The Workspace window presents different perspectives of your project.
Select a tab at the bottom of the window to display a list of the project’s
classes, resources, data sources, or files. Click the small plus (+) or minus
(-) buttons in the window to expand or contract a list. Expanding the list
of classes, for example, displays the names of member functions, as shown
in the first screen of Figure 1-6. Double-clicking the text of a list heading
adjacent to a folder or book icon has the same effect as clicking the head-
ing’s plus/minus button.
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Figure 1-6.
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Four panes of the Workspace window.

The Workspace window can display up to four panes of information,

described here:

B ClassView—Lists classes and member functions in the project. To
open the class source file in the Visual C++ text editor, double-click
the desired class or function in the list.

W ResourceView—Lists project resource data such as dialog boxes and
bitmaps. As with the ClassView pane, double-clicking a data item in
the ResourceView list opens the appropriate editor and loads the

resource.

m FileView—Lists the project’s source files. Copying a source file to
the project folder does not automatically add the file to the list in
the FileView pane. You must specifically add new files to the pro-
ject using the Add To Project command on the Project menu.

B Data View—Displays information about data sources for database
projects. The Data View tab appears only in database projects hosted
by the Visual C++ Enterprise Edition that are connected to a data

13
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Figure 1-7.

source compliant with the Open Database Connectivity (ODBC)
standard.

Right-clicking an item in the Workspace window displays a context menu
containing frequently used commands. Commands on the menu depend
on which item is clicked. Right-clicking a source file in the FileView
pane, for example, displays a context menu that lets you quickly open or
compile the file. You can also toggle individual Workspace panes on and
off. Right-click any tab at the bottom of the Workspace window to display
a context menu, and then choose the desired command from the menu list
to make the pane visible or invisible.

The Output window (shown in Figure 1-7) has four tabs named Build,
Debug, Find In Files 1, and Find In Files 2. The Build tab displays status
messages from the compiler, linker, and other tools. The Debug tab is
reserved for notifications from the debugger alerting you to conditions
such as unhandled exceptions and memory violations. Any messages your
application generates through the OutputDebugString API function or
afxDump class library also appear in the Debug tab.

dCompiling. ..
Cube.cpp

Cube.obj - 0 error(s). 0 warning(s)

PR s
d

The Ouput window.

The remaining two tabs of the Output window display the results of the
Find In Files command chosen from the Edit menu. (This useful feature,
similar to the UNIX grep command, is examined in more detail in Chap-
ter 3, The Text Editor.) By default, the Find In Files search results appear
in the Find In Files 1 tab of the Output window, but a check box in the
Find In Files dialog allows you to divert output to the Find In Files 2 tab.
The Output window can contain other tabs as well. We’ll see in Chapter
13 how to add a custom tool to Visual C++ that can display messages in its
own tab of the Output window.
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Online Help

Visual C++ provides three different sources of online help:

m Standard HLP files displayed with the WinHIp32 viewer
B Pop-up help messages in dialogs
m The Microsoft Developer N